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PREFACE

Dear Customer,

Congratulations on purchasing our innovative BCS-2® software. BCS-2®, with its 
Basic-Capturing-System, is a reliable and powerful scan client, especially adept 
at  scanning  books,  magazines  and  other  bound  media.  BCS-2® comes 
equipped with a multitude of functions to edit and if desired publish your scans.

BCS-2® is compatible with all available scanners that have Network- and HiS­
can-ports  as well  as those with ISIS- and TWAIN-Drivers.  Essentially,  every 
overhead-, flatbed-, sheet-feed- and microfilm-scanner, as well as digital copy 
machines, can be used in conjunction with the BCS-2® software.

The user-friendly and intuitive interface, based on the Windows operating sys­
tem, is one of the BCS-2® trademarks.

With its modular makeup, BCS-2®  provides the specifically required program 
components as needed. Our sales team will  assist you in compiling a fitting 
BCS-2®  packet for the job at hand, including all the optional software modules 
to meet your individual needs. Maximum user-comfort and utility with no unnec­
essary functions is the BCS-2® concept.

Should there be any questions concerning the BCS-2® software please consult 
your professional retailer, an ImageWare Partner, or ImageWare Components 
GmbH directly at bcs-2@imageware.de.

Successful scanning,

ImageWare Components GmbH
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1  INTRODUCTION

Dear user,

This newly reworked instruction manual thoroughly describes the functions of 
the BCS-2® software.

The program is designed as a modular system, consisting of basic modules 
and optional modules. In this user manual all features and functions of the ba­
sic modules of the BCS-2® software are described. The modules labeled as op­
tional modules may not as yet be fully documented and explained in this manu­
al. It is also possible that a few features mentioned in the manual only work in 
conjunction with scanners of the Bookeye® family. Should this be the case it will 
be noted at the appropriate place.

The manual starts with the Quick-Guide, a brief overview of the BCS-2® soft­
ware, intended for quick access to the program. This section is recommended 
for advanced and experienced users,  particularly those already familiar  with 
older versions of the software.

Following the Quick-Guide, the main section of the manual explains everything 
the BCS-2® software offers in detail: the installation process, the user interface, 
basic functions and especially the Order-Mode. The manual then covers all the 
program's menus in the order they appear in the software. Principally important 
menu points are treated in their own respective chapter.

For information regarding a certain command or process, please consult the 
content menu or keyword index.

To ensure product quality, BCS-2® is permanently under review by our special­
ists. Should you nonetheless come across mistakes or errors in the program or 
manual we would appreciate you contacting us at bcs-2@imageware.de.
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2  QUICK-GUIDE

2.1 Getting Started
This Quick-Guide covers the most important steps of the installation process, 
and everything necessary to complete a single scan to allow for a speedy entry 
to the BCS-2®  software.

Requirements: The correct driver of the scanner that is to be used needs to be 
installed, and the operating system on which BCS-2® is to be installed needs to 
be compatible with the software (see chapter 3.1, page 4).

Caution: The Quick-Guide is only intended as a brief getting-started summary 
and does not replace the more comprehensive main section of the manual. In 
the Quick-Guide, steps are deliberately only cursorily addressed and explana­
tions kept to a minimum. Numerous other practical options and possible set­
tings are not covered at all. For more in depth information on the appropriate 
step or topic concerning the BCS-2® software, please consult the matching sec­
tion of the manual.

2.2 Installation
 Make sure you have administrator rights on the PC you are using and 

that the appropriate driver for the scanner to be used has been in­
stalled properly.

 Insert the CD into your CD-ROM drive. Should the setup program not 
appear automatically, start the "Setup.exe" from the CD. Follow the in­
structions of the setup program.

 You can now start the BCS-2® software by double-clicking on the new­
ly created desktop icon. Confirm all messages that appear while start­
ing the software with "OK".

2.3 Software Registration
 In the "Extras" menu, select the "Perform/Change Software Regis­

tration..." option. Complete the licensing form and send it to Image­
Ware Components via e-mail or fax.

 You will then receive a license-file from ImageWare Components. You 
can  import  this  file  into  BCS-2® using  the  option  "Import  License 
File..." in the "Extras" menu. If the license is valid, you will receive a 
short  confirmation message.  If  this  is  not  the  case,  you  will  be in­
formed why your license was not accepted.
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2.4 Selecting a Scan-Mode and Scanner
 Select a Scan-Mode, in the "Scanner" menu, in which you would like 

BCS-2® to run (for example Mode: TWAIN, Mode: Network etc.). Fol­
lowing your mode selection you will  be asked to select the scanner 
you wish to use.

 If  you are not  prompted to select  a scanner automatically,  you can 
choose the appropriate scanner you wish to use with BCS-2®  by se­
lecting the "Select a Scanner..." option in the "Scanner" menu. After 
you have successfully selected the scanner you wish to use, its name 
will appear at the bottom right of the BCS-2® status bar.

2.5 Creating Single Scans
 In the first drop-down menu of the drop-down bar, to the right of the 

"Scan" button, select the "Single" Order-Type. By selecting the "Sin­
gle"  Order-Type,  you  activate  the  single-scan-mode of  the  BCS-2® 

software, which is most suited for the first scans due to its simplicity 
(see chapter 5.1 page 16).

 To start a scan, place the document you wish to scan properly on your 
scanner  and then press the "Scan"  button in the drop-down bar.  If 
necessary, press the scan button on your scanner.

Illustration 1: Starting a Single Scan

After the scan is completed, the scanned document will appear on the 
screen.

 To create more single scans, simply repeat the previous step. The ad­
ditional scans will also appear in the BCS-2® user interface.

Note: Scans created using the Order-Type "Single" are stored  in the directory 
"C:\Programs\BCS2_32\scn_data" by default. The directory is named after the 
"BC2_xxxx" scheme, where "xxxx" represents the number of the scanned doc­
ument.  Accordingly,  the  first  scan  has  the  name  "BC2_0001",  the  second 
"BC2_0002", and so on.
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3  INSTALLATION

3.1 Installation Requirements
For a successful installation of the BCS-2® software, an IBM-compatible PC (i.e. 
no Mac) with the operating system Windows 2000, Windows XP or Windows 
Vista is required. The PC's processor clock speed should be at least 1GHz (al­
though 2GHz or more are recommended) and the computer should have at 
least  1GB of  memory.  The screen resolution  should  also be  a  minimum of 
1024x768 pixels, although again a higher resolution of 1280x1024 pixels is rec­
ommended.

Installing BCS-2® will take up only about 60MB of hard disk space. However a 
few gigabytes of  free disk space should be kept available for  the saving of 
scans and scan orders.

3.2 Installation
 Make sure you have administrator rights on the PC you wish to install 

the BCS-2® software.

 Insert the BCS-2®-CD into your CD-ROM drive. Should the setup pro­
gram not appear automatically, start the "Setup.exe" file from the main 
folder of the BCS-2®-CD.

 In the following dialog select the language BCS-2® is to be installed in 
and confirm the choice by clicking the "OK" button:

Illustration 2: Selecting a Setup Language

 Follow the instructions of the setup program and confirm your choices 
with "Next" to continue through the installation process.

Caution: To  be  able  to  install  the  BCS-2® software,  the  licensing 
agreements must be agreed to by selecting the "Yes" box!
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 Enter the user name along with the company name and confirm by 
clicking "Next":

Illustration 3: Entering User Information

 Choose the folder in which BCS-2® is to be installed and confirm by 
clicking "Next":

Illustration 4: Selecting Target Directory

Note: The default settings of the setup program will install BCS-2® into 
the directory: "C:\Programs\BCS2_32\".
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 Select the setup type "Standard" and confirm by clicking "Next":

Illustration 5: Selecting the Installation Type

Note: By  choosing  the  "Scanner  Simulation"  installation  type, 
BCS-2® can be installed for testing or demonstration purposes. Each 
simulation scan calls forth an image from the "examples" folder of the 
BCS-2®  software, rather than actually receiving a scanned image. No 
scanner is required for this to work.

 Choose an existing folder in the start menu or create a new one and 
confirm by clicking "Next": 



Illustration 6: Selecting a Program Folder
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 The setup program will now copy the necessary files to the previously 
selected  directory,  generate  the  start  menu  symbols  and  create  a 
desktop icon. When the installation is complete, a message will  ap­
pear. Confirm this message with "Finish", to conclude the installation 
process:

Illustration 7: Setup Completion

 The installation has now been completed and BCS-2® is ready to be 
launched.
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3.3 Following the Installation
After  the  installation process  has  been successfully completed,  the  BCS-2® 

software can be launched by double clicking the desktop icon, or selecting the 
appropriate icon in the start menu.

When BCS-2® is started for the first time, the following messages will appear 
and need to be confirmed by clicking the "OK" button:

 Error message regarding the need for a valid license:

Illustration 8: Licensing Problem

This error message appears if the BCS-2® software cannot find a valid 
license file. To register the software and receive a license please fol­
low the steps explained in chapter 3.5: "Software Registration". 

 Message regarding the necessary selection of of a Scan-Mode:

Illustration 9: Scan-Mode Error

To be able to use BCS-2® with a scanner connected to the PC, the ap­
propriate Scan-Mode needs to be activated (see chapter  11.2 page 
72).

8



3.4 Installing Updates
A fully installed release version of the BCS-2® software is necessary to install 
an update. It is recommended that you create a back-up copy of the BCS-2® 

program folders before you install the update. To install an update, follow these 
steps:

 Make sure you have administrator rights on the PC you wish to install 
a BCS-2® update on.

 Make sure that the Order-List within BCS-2® is empty (it is by default if 
you have just installed and/or have not used the software).

 If the program is open, close BCS-2®.

 Extract all files including sub-folders from the update archive (a ZIP 
file) into the BCS-2® program folder (default: 
"C:\Programs\BCS2_32"), overwriting all existing files. When all files 
have been copied, the updating process is complete.

 After BCS-2® is restarted, the number of the new version should ap­
pear in the title bar of the software.

Caution: It is possible that after updating the software and starting BCS-2® for 
the first time, a message concerning new Order-Types will appear. Confirm this 
message by clicking "OK", to start the program.

3.5 Software Registration
In order to be able to use the BCS-2® software with all its functions, a valid li­
cense is required. If BCS-2® cannot find a valid license, it will start in the demo-
mode. In the demo-mode, each scanned image will be marked with a "DEMO" 
label. The error message notifying you of the license problem when BCS-2® is 
started can be confirmed by clicking the "OK" button:

Illustration 10: Licensing Problem

Note: A new license is required if one of the following conditions applies:

 New purchase of the BCS-2® software or optional modules

 Hardware- or software change (new installation)
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 Update or upgrade of the BCS-2® software

 Modification of the licensing data

 Passing the expiration date of the current license

BCS-2® needs to be unlocked by activating a license as described in the follow­
ing section.

3.5.1 Activating a License
To activate a BCS-2® license, a valid license file must be imported. To request a 
license file, follow these steps within the BCS-2® program:

 In the menu bar select the "Extras" menu.

 Select the option "Perform/Change Software Registration...".

 A registration wizard will now guide you through all necessary steps 
required to request a license. Once the wizard is complete, a license 
file will be sent to you by ImageWare via E-Mail (typically within one 
weekday).

To import the license file into the BCS-2® software:

 In the menu bar, select the "Extras"  menu, and then the option "Im­
port License File...". In the dialog that appears, select the license file 
that was sent to you by ImageWare, and confirm with the "Open" but­
ton. 

 When the license activation is complete, full access to BCS-2® and all 
its functions is unlocked. This will be confirmed by the following mes­
sage:

Illustration 11: Successful License Activation

Confirm this message by clicking "OK".
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4  BASIC FUNCTIONS AND ORGANIZATION

4.1 Launching the Software
When launching the program the driver for the selected scanner is loaded. If a 
necessary file  cannot  be found,  an error message will  appear,  showing the 
name and supposed location of the missing file. The appropriate file can then 
be inserted, for example using Windows Explorer. After the program was suc­
cessfully started you will see the main window of BCS-2®. The user interface 
will be described in more detail in the following chapters, starting directly with 
4.2. 

4.2 Organization of the Main Window
BCS-2®'s organization is based on the common interface found in many Win­
dows programs. Beneath the "Title Bar“, which displays the installed version of 
the software and which Order-Mode the program is in, is the "Menu Bar“:

Each of the important menus of the "Menu Bar" are described in its own chap­
ter in this manual.

Beneath the "Menu Bar" is the "Button Bar":

The  "Button Bar"  gives quick access to the most important functions of the 
program. The buttons are sorted into groups of "similar" functions. Should the 
meaning of a button be unclear, move the cursor over that button. This will im­
mediately make a short description appear in the status bar at the bottom of the 
program window. If your cursor rests over the button for a short time, a small 
yellow window will appear giving a brief description of the button (Mouse-Over-
Effect).

Note: When working with  the BCS-2® software,  the buttons of  the  "Button 
Bar" are the quickest and most convenient way to use functions, for example to 
rotate an image by 90 degrees. If a section in the manual discusses a function 
that can also be activated by a button, the appropriate button will also be men­
tioned at that time.

Beneath the "Button Bar" is the "Dropdown Bar" (see chapter 4.3 page 13), 
with which all significant settings concerning the scan process can be adjusted.
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Beneath the "Dropdown Bar" is the  "Workspace" of BCS-2®, which is made 
up of two parts:

On the right side, each opened or scanned image is displayed in a seperate 
window.

At the same time the left side will display thumbnails of all open images, sorted 
vertically, for quick access.

Illustration 15: Dropdown Bar with Workspace below
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4.3 Dropdown Bar Settings

Illustration 16: Dropdown Bar

The available options (from left to right):

 Pressing the "Scan" button will create a single scan, if the Order-Type 
"Single" is selected (the Order-Type for single scans). The scanned 
image will appear on the left as a thumbnail and on the right in its own 
window. If a different Order-Type is set, pressing the button "Scan" will 
create a new order. This will also start a new scan if "Start with  Pro­
gram" has been selected in the order options (see chapter 5.5.1 page 
26).

 The Order-Type can be selected in the first dropdown menu (the illus­
tration shows the "Standard" Order-Type selected).

 The second dropdown menu can be used to select the format of the 
document  that  is  to  be  scanned.  The document  you  wish  to  scan 
should be placed in the appropriate area of the scanner.

 The third dropdown menu adjusts the resolution. Changing the reso­
lution will directly affect the size and quality of the created image file.

 The fourth dropdown menu (the active menu in the above screenshot) 
changes the page setup. The orientation can be set to either portrait 
(vertical format) or landscape (horizontal format).

 If the checkbox "Bright. at Scanner" is checked, brightness and con­
trast can be adjusted directly at the scanner.

If the checkbox "Bright. at Scanner" is not checked,  brightness and 
contrast can be adjusted using the two sliders. How much the sliders 
can be adjusted depends on the selected scanner.

 If the scanner in use has a document feeder, checking the "ADF" box 
will activate it.
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4.4 Edit Image Context Menu
The "Edit Image Context Menu" is opened by right clicking on an image in the 
workspace. This menu contains standard options such as zooming in and out, 
rotating, despeckle, etc. (see chapter 10 page 55).

Illustration 17: Edit Image Context Menu

All menu points shown above can also be accessed via the menus in the menu 
bar and are documented at the appropriate point in the manual

Caution: The edit image context menu will change for certain image editing op­
tions (for example if masking or page splitting is activated).
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4.5 Key Bindings
It is possible to almost exclusively operate the BCS-2® software with your key­
board.

Key Function

ESC Leave current order (Order-Mode)
Close current image (in Order-Type "Single")

F1 Help

F2 View image in original size

F3 Fit image to height of window

F4 Fit image to width of window

F5 Fit image to window

F6 Use despeckle on current image

F7 Use deskew on current image

F8 Display in greyscale

F9 Turn print after scan on/off

CTRL+F9 Rotate wide images on print

SHIFT+F5 When assigning barcode positions: delete all rectangles

SHIFT+F9 Save current order as Multi-TIFF

F11 Split page mode on/off

SHIFT+F11 Mask

H If Mask is active: toggle separation line in mask

CTRL+A Maximize window automatically

CTRL+C Copy selection to clipboard

CTRL+M Send current image via e-mail (Order-Type "Single")
Send current order via e-mail (other Order-Types)

CTRL+O Open file

CTRL+P Print current image or order

CTRL+S Start scan or order

CTRL+V Paste from the clipboard

CTRL+X Cut to the clipboard

CTRL+Z Undo last action

Arrow left Scroll image left

Arrow right Scroll image right

Arrow up Scroll image up

Arrow down Scroll image down

Page up Thumbnail bar: move up one image

Page down Thumbnail bar: move down one image

Enter Thumbnail bar: open/activate selected image
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5  ORDER-MODE AND ORDER-TYPE
The BCS-2® software greatly facilitates the completion and management of en­
tire scan orders. The different  Order-Types, which can be edited or created, 
make working with BCS-2® productive and easy. BCS-2® also gives you the op­
tion of defining your own Order-Types, which will be explained later in the man­
ual (see chapter 13.7 page 96).

Once all pages of an order have been scanned, the order itself can be saved, 
printed, transferred or sent to a desired location. Orders can also be exported 
from, and imported into BCS-2® effortlessly.

Caution: For more information concerning the difference between the terms 
"Order-Mode" and "Order-Type" see chapter 5.3, page 19!

5.1 Basic Order-Types
Following basic Order-Types exist in BCS-2®:

 Single: A very plain BCS-2® Order-Type for single scans, therefore not 
suited for piles of images i.e. scans. The "Single" Order-Type is most 
suitable  for  testing purposes.  Transferring an order  is not  possible. 
The images of  the Order-Mode "Single"  are stored in the directory 
"C:\Programs\BCS2_32\scn_data"  by  default  (see  note  in  chapter 
2.5 page 3).

 Simple: The most simple Order-Type. No indexes are necessary for 
"Simple" orders. Transferring an order will copy the images to target 
location (by default "C:\Simple"). No sub-folders for individual orders 
are created.

Note: When transferring an order of this type, no "order.sum" file is 
created like it is in for other Order-Types (see chapter 5.6.8 page 41).

 Standard: The  standard  Order-Type for  an  individual  setup.  Up to 
nine indexes can be freely defined (see chapter 5.5.7 page 32). If de­
sired, these nine indexes can appear on the cover sheet of the order 
(page one) as a barcode. The barcode areas for each index can also 
be freely defined with BCS-2®. Transferring copies the images into a 
newly created folder within the target directory for "Standard" orders. 
This new folder will be named with the order number. In addition to the 
images a small ASCII file labeled "order.sum" will be created. This file 
contains the most important data of the order.
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5.2 Additional Order-Types
BCS-2® also supports a series of optional and additional Order-Types, which in 
part require their own license.

 ADAM: Order-Type to connect BCS-2® to ExLibris ADAM (Aleph Digi­
tal Asset Management). When an order is transferred with this Order-
Type, the program checks if a web publisher template named ADAM 
exists. If  this is not  the case, the process is aborted and an  abort 
message appears. If the ADAM configuration exists, an upload via the 
web publisher will take place. The original images will not be copied to 
an additional folder as usual.

 ARIEL_BATCH: This Order-Type is intended to export scanned pages 
into a preset structure from which an Ariel station can then easily im­
port the images.

 CAR (Computer Aided Retrieval): See Order-Type "Standard". Dis­
tinction:  When transferring, the existing file names will  be used. No 
sub-folder for the individual orders is created. A request for target di­
rectory before transferring can be activated in the order options.

 Define-Tags: This Order-Type is a variation of the "Standard" order. It 
gives the additional option of defining TIFF tags, which are implanted 
into the TIFF images of the order when the order is transferred.

 ILLIAD: Connection of BCS-2® to Illiad, an electronic document deliv­
ery system used in the United States. 

 Jason: BCS-2® is used as a scan component of the JASON system. 
This  Order-Type  is  used  in  conjunction  with  Jason/Medea.  Order 
pages are newly numbered and renamed in the order folder to the Ja­
son order number. This number is placed on the cover sheet (page 
one) as a barcode, and is recognized by BCS-2®.

 Medea3: This  Order-Type enables the communication  of  the docu­
ment delivery system Medea3 and BCS-2®.

 MyBib eDoc: Order-Type in which BCS-2® functions as a scan client 
for MyBib eDoc, a web based document delivery system designed for 
quick and inexpensive electronic delivery of non-returnable documents 
(Scan-on-Demand).

 ODYSSEY: Order-Type for the export of orders to Odyssey.

 SCAN2WEB:  This Order-Type transmits documents to a web server 
when the order is transferred. By means of an automatically created 
web address, the scanned images can be accessed by any PC with 
an Internet connection.

 SISIS: Order-Type connecting BCS-2® to the SISIS  Sunrise Library 
system.
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 Subito: Order-Type allowing BCS-2® to be used as a scan station in 
an SUBITO environment.

 XPC: This Order-Type connects BCS-2® to an XPrint-Server system.
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5.3 Choosing Order-Type and Order-Mode
In order to process a scan order with BCS-2®   it is necessary that an Order-
Type is selected. To do so, simply select the appropriate Order-Type from the 
dropdown menu in the dropdown bar in the BCS-2® main window (see chapter 
4.3 page  13). Actual work with the scan order now takes place in the Order-
Mode (Order-Type → Order-Mode), with the exception of the Order-Type "Sin­
gle", which is a stand alone scan-type/mode.

Before an order is created, the order options should be looked over and if nec­
essary adjusted (see chapter 5.5 page 24).

Caution: The terms "Order-Type" and "Order-Mode" are often used synony­
mously, but this has no effect on the explanations in the manual:

The selection of the Order-Type simply puts the program into the correspond­
ing  Order-Mode of the same type and name. For example, if the Order-Type 
"Standard"  is  selected,  you  will  be  working  in  the  "Standard"  Order-Mode 
when you start a new order.

5.4 Working in the Order-Mode
Caution: Make sure you are in the desired Order-Mode! The Order-Mode is de­
fined by the Order-Type (see above).

5.4.1 Creating an Order
By selecting the menu point "Create" in the "Order" menu, an order of the type 
currently selected in the dropdown bar will be created. Clicking the "Scan" but­
ton will also initiate a new scan order. After an order has been started, the Or­
der Bar will appear directly beneath where the "Scan" button used to be, which 
has now disappeared there and moved down into the Order Bar.

5.4.2 Order Bar

Illustration 18: Dropdown Bar with Order Bar below

This bar contains the following options:

 "Scan": As before, the scanning process can be started with this but­
ton. Alternatively, the key binding CTRL+S can be used to start scan­
ning.

Should a scan not come out as desired, it can always be removed by 
selecting the appropriate thumbnail of the scan, and pressing the DEL 
key, or the corresponding button in the button bar. In all Order-Modes 
except the "Single" type, a removal confirmation request will appear. If 
an image is to be inserted at a certain position, the thumbnail  after 
which the new image is to be inserted needs to be selected. Now all 
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new scans will be inserted behind the selected image. By default the 
last image is always selected, and all new scans are added at the end 
of the current images.

Button bar icon for deleting an image:  

 "Rescan":  The  image  currently  selected  by  thumbnail  will  be  res­
canned, and the new image will replace the old one. Index information 
and other meta data like OCR texts are carried over to the rescan, and 
do not need to be re-created/edited.

 "New Order": The current order will be closed and a new order of the 
currently selected Order-Type will be created.

The Order Bar contains two more areas:

 "Status": Here the current page of the order, as well as the total num­
ber of pages of the order are displayed. Furthermore, the cumulative 
size of the scan order is displayed in kilobyte. In the yellow box the 
current pagination level (see chapter 5.5.9 page 36)  i.e. page number 
of the active page is shown.

 In the box on the very right, beneath the Order-Type ("Standard"  in 
the screenshot above) is the  job number, followed by the indexes.

5.4.3 Ending the Order-Mode
To end the Order-Mode, simply click the "Stop" button in the order bar. The or­
der will conclude and the order window with the order list will appear (see chap­
ter  5.6 page  38). Alternatively you can end the Order-Mode by pressing the 
ESC key.

5.4.4 Drag & Drop
TIFF  and  JPEG  files  can  be  “dragged”  from  the  Windows  Explorer  and 
“dropped” into the BCS-2® workspace via the mouse cursor. These images will 
then be integrated into the order. In the "Single" Order-Mode the image will be 
opened and displayed.

ZIP files along with the files they contain can also be imported into BCS-2® via 
the drag & drop feature (see chapter 5.6.15 page 45). After confirmation, the or­
ders in the ZIP file are imported. If an order is already open, the contents of the 
ZIP file will be integrated into the open order.

5.4.5 Capturing Indexes via Barcode (optional)
Requirement: BCS-2® Barcode module

Capturing indexes via barcode is the easiest way of categorizing a scan order 
or identifying the original document. Up to nine indexes (keys) can be defined, 
and if desired displayed via barcode1 on the first page of the order. For exam­

1 Barcode: BCS-2® supports the following barcodes: UPC-A / -E, Code 39 / -128, EAN8 / -13, Interleaved 215 , 
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ple, the customer and order numbers can be assigned to each scan order. For 
this, the order sheet is scanned as the first page of the scan order, and the bar­
code information is automatically read and registered.

When working with indexes in BCS-2®:

 For each Order-Type individual lists of order  indexes can be created 
and managed.

 In the dialog window that appears after the first page of an order has 
been scanned, a separate list can be managed for each key (index).

 To the right of the input field (in which the lists can also be selected) 
the number of entries is displayed.

 A button exists for each of the up to nine indexes to transfer the cur­
rent entry into the list, or to remove the current entry from the list.

 The lists are stored in the same folder as the scan orders. The files 
are  named  after  the  corresponding  Order-Type,  for  example  for 
"Standard" orders: "Std_KEYS.DAT".

 Each entry has its own row, and each row starts with the number of 
the index.

Example: "Standard" order with three indexes:

1:blue

2:Volume 1

3:Henry

1:red

2:Volume 2

3:Paul

The order of the items is irrelevant. BCS-2® recognizes to which key the text be­
longs by the first two characters in a row. In the dialog window the keys are 
sorted alphabetically.

CODABAR and ITF.
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5.4.6 Setting Barcode Position (optional)
Requirement: BCS-2® Barcode module

With the option "Set Barcode Position..." in the "Order" menu, the barcode 
position on the first sheet of the order is set so that  BCS-2® "knows where to 
look".

Illustration 19: Defined Barcode Positions

Once BCS-2® has recognized a barcode and its position, no new recognition is 
necessary unless the barcode position changes.

Caution: Before the barcode position for an Order-Type can be set, the appro­
priate Order-Type needs to be selected (see chapter 5.3 page 19). This has to 
occur before an order of the selected type is created, as editing the barcode po­
sition is not possible within an order.

Setting Barcode Position:

 First,  select  the  desired  Order-Type  in  the  dropdown  menu  in  the 
BCS-2® main  window  and  place  the  document  with  the  barcode 
BCS-2® is to recognize on the scanning area of your scanner.

 Next select the option "Set Barcode Position..." in the "Order" menu. 
The document will now be scanned. Subsequently the message ask­
ing you to "Please Select Barcode-Area using the Mouse!" will ap­
pear. Confirm by clicking "OK".

 Move the mouse cursor to a corner of the area occupied by the bar­
code.
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 Press and hold the left mouse button.

 Drag a box which contains the entire barcode (and only one barcode – 
even if this differs on latter sheets).

 Release the left mouse button.

 If the error message "Barcode was *Not* detected !" appears, con­
firm this message and try again.

 Select the barcode areas generously! The barcode positions of latter 
scans can be slightly moved or misplaced. The BCS-2® software just 
needs to recognize the entire area of one single barcode.

 A message you need to confirm will tell you if the barcode recognition 
was successful. A window will appear in which the barcode needs to 
be assigned to an index. This is done by marking with the left mouse 
button and confirming by clicking "OK".

 Repeat the above steps until all indexes have their corresponding bar­
code (see screenshot).
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5.5 Order Options and Options Dialog Window
Before creating an order, the set  options should be checked and if necessary 
adjusted.  In  the  dropdown bar select  the  desired  Order-Type (ex.:  "Stan­
dard"), then in the "Order" menu the "Options..." option.

The options dialog window will appear, showing all relevant settings for the 
selected Order-Type.

Options Dialog Window Areas:

 Scan Start Options

 Barcode Options

 General Settings for an Order-Type

 Post-Scan Conversion

 The "PDF ..." button opens a dialog widow with settings for converting 
to a PDF file

 The "MAPI ..." opens a dialog window in which the text, added to auto­
matically generated e-mails when sending scans, can be edited

 The "Order Indexes..." button opens a dialog window with options for 
editing the index keys.

 The "Page Index..." button opens a dialog window with options for ad­
ditional index keys for each scanned page

 The "Pagination..." button opens a dialog window with pagination op­
tions 

 The  "BCS-2  Variables..."  button,  allows  for  BCS-2®  variables  (see 
chapter 13.2 page 90) to be entered into an active input field (yellow 
box) in the option dialog window. For more information about BCS-2® 

variables select the "Documentation of System Variables" option in 
the  "Help" menu.

The different areas and buttons of the options dialog window can be seen in the 
following screenshot,  following which the individual  options are explained in 
more detail.

24



Illustration 20: Order Options Dialog Window (active Order-Type: "Standard")

Note: Pressing the "OK" button in a dialog window will apply the current set­
tings and close the dialog window.

If you do not wish to save the changes you have made, click the "Cancel" but­
ton.  The options dialog  window will  be closed and the changes will  not  be 
saved.

In the following section the options for individual orders will be covered. Their 
arrangement follows that of the options dialog window.
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5.5.1 Scan Start Options
One of the three available options for how to start scanning can be selected 
here by clicking the button of the desired option:

 "Start at Scanner": Scans are started by pressing the appropriate but­
ton on the scanner (if the scanner is network-compatible and has a 
start  button,  for  example Bookeye® family scanners with  a  network 
port). The scan order will now be completed in the pile mode. Com­
plete handling of  the scan order  occurs at  the scanner.  Scans are 
started at the scanner (for example via a foot pedal). Being able to ini­
tiate scans at the same location at which the documents are prepared 
for scanning makes this a very efficient way to work.

 "Start with Program": If this option is selected, scans are started by 
clicking the "Scan" button in the order bar.

 "Scan Automatically Every _ sec.": This option offers the convenient 
option of having the BCS-2® program start scans in predefined inter­
vals. The time interval between scans needs to be entered into the in­
put box (in seconds). An endless scan loop with the set time interval 
can be started in this way.

A separate window will show the countdown to the next scan. The au­
tomatic scanning process can be stopped at any time by pressing the 
ESC key or clicking the "Stop" button in the order bar. This mode of 
scanning can, for example, be useful for scanning books, so that only 
the page needs to be turned and the scans are started automatically.

5.5.2 Barcode Options (optional)
Requirement: BCS-2® Barcode module

For the capture of indexes via barcodes there are two available options:

 "Decode Automatically (Page 1)" If this option is selected, the pro­
gram expects all barcodes on the first page of the order. The location 
of the barcodes as well as the assignment of the barcodes to the in­
dexes has to be configured before the scan with the "Set Barcode Po­
sition..." option in the "Order" menu (see chapter  5.4.6 page  22). If 
the automatic recognition fails, the  indexes have to be manually en­
tered. 

 "Always Enter Manually" if this option is selected, all indexes need to 
be entered manually at the start of the order.
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5.5.3 Order-Mode General Settings
The general settings of the selected Order-Mode can be edited in the Order-
Mode  options area (the  currently  selected  Order-Mode  will  be  displayed  in 
parentheses behind the label “Order-Mode”, for example: "Type: STANDARD")

Explanation of the Different Boxes:

 "Shortname": Displays the abbreviation of the currently selected Or­
der-Type. This label can be modified here.

 "Abbrev.": Is intended for internal labeling of an order in the "order.­
dat" file created for each order.

 "Identification": Display the currently selected Order-Type by its la­
bel. This label can be modified here.

 "Target Dir.": Here the target directory is set, into which the entire or­
der will  be transferred when completed. For each order a new sub-
folder will  be created containing the individual images of that order. 
This will not occur for the Order-Types "Single" and "Simple".

 "Filename": Optionally a name for each image file can be entered 
here for when the order is transferred,.

 If the checkbox "Confirm Re-Transfer of Order" is checked, a confir­
mation request will appear when transferring an order again, asking if 
the re-transfer is to really take place.

 Checking the checkbox "Delete Order after Transfer" will cause the 
images of a scan oder to be deleted from the sub-folder "scn_data" in 
the BCS-2® directory after the transfer of an order. This is a useful op­
tion for saving hard drive space.

 If the checkbox "Ask for Target Dir." is checked, you will be asked to 
select the target directory before each order transfer.

 The checkbox "Transfer as Multip. TIFF File" will cause all images to 
be stored in a single TIFF file  upon order transfer.  This multi-page 
TIFF file is a multi-page document and will be saved into the target di­
rectory. No sub-folders are created for the individual scan orders.

 The option "Convert during Transfer?" determines if the images are 
converted to a certain format during transfer. You can choose between 
the JPEG, PNG and TIFF formats, and the compression factor can 
also be defined.

 The option "In Scan Order: Print Entire Order" allows you to, within 
the order itself, completely print the order. Alternatively only selected 
pages or sections of the order can be printed. This is selected in the 
print dialog window. If this option is left unchecked, pressing the print 
button will only print the image that is currently in the workspace.
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 Checking the option "In Scan Order: Start with A4 Portrait" will set 
pages of a new scan order to A4 and portrait format. This option can 
be very practical for certain Order-Types as the first page is often of 
A4 portrait format and contains one or more barcodes.

 The dropdown bar "Split/Masking after Creation" offers options for 
splitting  and  cutting  individual  images.  For  example,  a  permanent 
mask for cutting out certain parts of an image can be activated. (see 
chapter 10.5.2 page 62).

 The section of the options dialog window shown in the screenshot be­
low is inactive by default (compared to screenshot on page 25):

Illustration 21: Option Dialog Cutout

The  input-boxes  are  only  active  in  the  Order-Modes  "Single"  and 
"Simple":

 "File Prefix": In this input box the file name under which scans 
are saved can be edited. The file name consists of a freely defin­
able  prefix and a number,  which will  increase by one for each 
scan.

 "Startnum.  and  Endnum.": Here  the  start-  and  end-numbers 
that make up the suffix of the file name can be set.

 Checking the option "Always Start Numbering with 1?" starts 
the counter at one for the first scan of an order.

 Checking the option "Overwrite Automatically?" will  cause old 
files to be replaced by new ones without confirmation request.
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5.5.4 Automatic Conversion After Scan
This area contains settings for converting all images to a single format.

 Activating the checkbox "Convert Images Automatically" will  auto­
matically convert all images within an order to the format selected in 
the target format box. This option is especially useful if the entire order 
is desired in a printable format.

 Following target formats are available: A2, A3, A4, A5, Legal, Letter, 
DLetter.

 The page orientation of the target format is always portrait.

 At the right end of the conversion options area are two boxes for ad­
justing the width and height.  This  is  useful  to  prevent  document 
edges from disappearing when using printers without automatic scal­
ing.

Note: The scan will be converted without taking into consideration the size of 
the original document. Small original documents can be excessively enlarged 
and large original documents possibly become so small they become unread­
able. Therefore results should be checked for their usability.

5.5.5 PDF Settings (optional)
Requirement: BCS-2® PDF module

Illustration 22: PDF Settings

The PDF Settings dialog window is split into the three areas: "Folders", "Mail 
Settings" and "Image Settings".
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 "Folders":

 "Target Directory": The directory in which the PDF files are to be 
saved is entered here.

 "Select Directory": The target directory where the PDF files are 
to be saved is selected with a file browser window.

 "Name of PDF File": Here the names the created PDF files are to 
receive  can  be  defined.  The  button  "Variables..."  allows  for 
BCS-2® variables to be implemented into the name of the created 
PDF  files.  The  button  "Standard"  will  enter  the  variable 
"ORDER_NAME" into the input field, which means the file name 
will be the job number of the scan order.

 "Delete Order after PDF Generation?": If  this checkbox is ac­
tive, the order will be deleted within BCS-2® after the PDF file has 
been created.

 "Create searchable PDF File  (optional)": Activating this option 
will use text recognition to create a searchable PDF file. This is 
only possible if the BCS-2® OCR module is installed.

 "Mail Settings":

 "Use Standard Settings": This options resets all settings for the 
mail attached to sent PDF files to a preset standard mail.

 "Subject  & Body": The text which will  appear in the e-mail ac­
companying sent PDF files can be defined here.  The variables 
found in the file "BCS2VARS.txt" in the BCS-2® program directory 
can be  used here.

Note: To insert a new line press the CTRL+ENTER key combina­
tion, as ENTER will close the dialog window.

 "Test": Clicking this button will render a preview of what the sent 
mail will look like.

 "Image Settings":

 "Convert TIFF/Grayscale/Color Images to JPEG?": If  this op­
tion is checked, grayscale or color images will be converted into 
the JPEG format. Black & white images are always saved as TIFF 
files.

 "JPEG Quality (1% - 100%)": This option regulates the quality of 
the JPEG compression. A high percentage value corresponds to a 
low compression rate. The higher the compression, the less disc 
space the JPEG image will take up inside the PDF file. However 
image quality can suffer with very high compression rates. The 
default value is 75%.
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5.5.6 MAPI Settings
Clicking the button "MAPI ..." in the order option window will open a dialog win­
dow with settings for sending e-mails via MAPI:

Illustration 23: MAPI Settings

 "Use Default Settings" (button): Fills the input fields in the "Mail" area 
with standard values (see screenshot).

 "Mail": In this input field the "Subject" (topic) and "Body" (content) of 
the e-mails can be defined. Normal text as well as BCS-2®  variables 
can be used, the latter accessed via the "BCS-2-Variable ..." button.

Note: To insert a new line press the CTRL+ENTER key combination, 
as ENTER will close the dialog window.

 "Test" (button): Clicking this button will  render a preview of  what a 
sent mail, without attachment, will look like.

 "Default Recipient": When sending e-mails, the address in this input 
field will be used by default.

 "Show MAPI Client (Outlook)" (checkbox): If this option is activated 
the MAPI  client  (e.g.  Thunderbird)  will  be started  when sending e-
mails via MAPI. Changes to the e-mail can be carried out here. If this 
option is not activated, the e-mail will be sent to the default recipient 
without opening the e-mail client. However, for this to work properly, 
the default recipient input field must not be empty.
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 "Convert  TIFF/Grayscale/Color  Images  to  JPEG?"  (checkbox): If 
this option is checked, all grayscale or color images to be sent will be 
converted into the JPEG format. The box "JPEG Quality" determines 
the level of compression (see page 30 "JPEG Quality").

5.5.7 Order Indexes
Clicking the "Order Indexes..." button opens a dialog window with settings for 
managing index keys:

Illustration 24: Order Indexes Dialog Window

In the areas "Index 1" through "Index 9" keys for up to nine indexes can be de­
fined for the current Order-Type. Three configurations must be defined per in­
dex:

 "Prompt": Here the name of the index, which will need to be manually 
confirmed, needs to be entered. If the appropriate box is to be acces­
sible via shortcut, a "&" needs to be inserted in front of the characters 
in the input box.

 "Name": The name the index will be saved in the "order.dat" file upon 
final transfer is defined here.

 "Length": If the checkbox "Fixed Length" is activated, the length of 
the indexes can be fixed here. If "Fixed Length" is not activated, the 
index length remains unrestricted.

Additional Options:

 The checkboxes "Index is Barcode" defines which  indexes will  be 
recognized as a barcode.
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 If the option "Use Last Value as Default?" is activated, the last index 
value will be used by default in a new order.

 Furthermore,  the "Prompt for Order Indexes before First Scan?" 
option determines if the index confirmation should occur before or af­
ter the first scan.
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5.5.8 Page Index
Clicking the  "Page Index ..." button opens a dialog window with settings for the 
page index:

Illustration 25: Page Index Configuration

Checking the "Use Page Index?" option will activate a query for an additional 
key for each scanned page. The page index can be compiled of up to three 
parts: prefix, the key itself (variable part, can be incremented automatically) and 
suffix.

The option "Suffix controls incrementing" will have the following effect: Is the 
option activated, a checking of the suffix box (which was previously empty) will 
deactivate the automatic incrementation, and decrement the already increased 
page number. 

When creating an order, an additional window with the definition of the addition­
al key will appear in the title bar, recommending the page index for the next 
page:

Illustration 26: Additional Window when Creating New Order 

34



This window contains the option "Increase Automatically". This option auto­
matically jumps to the next number after a page has been scanned. The index 
can be manually increased or decreased by pressing the "+" and "-" buttons. If 
prefix and suffix of the page index have been activated, additional input boxes 
will appear here or after the input box for the value of the indexes (both empty 
in the above screenshot).

Note: The option that recommends the page index before the scan can be de­
activated by checking the checkbox "Suggest before scan?" in the dialog win­
dow for  configuring  page  indexes.  When exiting  the  order,  before  transfer, 
BCS-2® checks if all pages have a non-empty page index. BCS-2® also checks 
if  any  indexes have  been distributed  twice.  After  checking  is  complete,  an 
overview is displayed. An order is not transferred should one of the two above 
cases apply.

A standard name, the BCS-2® order name and ending with".IDX", can be used 
for the  index files. The name can always be reset to the standard name by 
clicking the "Restore Standard" button. It is also possible to create an individu­
al name for the file, using the BCS-2® variables if desired ("BCS-2 Variables..." 
button).

The format of the index data for the index key within the index file can also be 
individually defined, or a standard setting used.

The checkbox "Use Index as the filename when transferring the images?" 
can be activated if the key is to be used as the file name for transferred images.
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5.5.9 Pagination
Clicking the "Pagination..." button will open a dialog window with settings for 
the structuring of  the pages of  the order and the selected Order-Type (see 
chapter 8.2 page 52).

The pagination (structuring) of an order can be used to carry over the organiza­
tional structure of the original document, for example a book, into the order it­
self. In this way, the order can be structured the same way as the scanned orig­
inal.

For each level of pagination the type of numeration can be set:

Illustration 27: Pagination Settings

Pages can be paginated during the scan process or afterwards.  During the 
scan process the "+" and "-" keys increase or decrease the pagination level of 
the page selected in the thumbnail list.

The  current  structure  can  be  viewed  in  a  separate  window,  which  can  be 
opened by selecting the "Pagination: Show Current Structure..." option in the 
"Order" menu. By moving the mouse cursor over a row in this window the pagi­
nation can also be changed with the "+" and "-" keys.

Note: The pagination function can also be accessed via the "Order" menu, see 
chapter 8.2 page 52.
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5.5.10 Password Protection for Order Options (optional)
Requirement: Valid and active license file

If this option of your license is active, a password-prompt message will appear 
when the order options dialog window is opened. Only when the password is 
correctly entered will the options dialog window be accessible.

The password request message will only appear once, so that after having cor­
rectly  entered  the  password,  the  options  dialog  window can  be  repeatedly 
opened without interruption. However, the password needs to be re-entered ev­
ery  time  the  BCS-2® software  is  restarted  and  the  options  dialog  window 
opened.

After the password has been successfully entered, the option to change it is ac­
cessed. To change the password, the new password needs to be entered twice 
to avoid spelling mistakes.
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5.6 The Order Window and Order List
The Order Window with the Order List opens when either an Order-Mode is 
stopped or by selecting the "Select..." menu point in the "Order" menu. Here 
scan orders are managed and processed.

Illustration 28: Order Window with Order List

The last order closed will appear at the bottom of the list. The last order opened 
in a BCS-2® session is colored, the backdrop of the number is colored in green. 
All orders can be managed and further processed from in this window.

Following information is displayed for the orders:

 Order: Order name or job number

 Type: Order-Type

 Date: Date the order was created

 Count: Number of images within the order

 Size: Size of the order in kilobyte

 Tr.: For orders already transferred this column will be marked here

 Pr.: If the order has already been printed, a mark will appear in this 
column

 Index 1,2,3...: If appropriate, the used indexes are displayed here

The orders can be sorted by the desired column by double-clicking on the col­
umn title. For example, all orders that still need to be transferred can be listed 
under each other. Double-clicking into the upper left hand corner selects all or­
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ders, which can also be done by pressing the key combination  CTRL+SHIFT
+END. All orders can be edited (ex. deleted) in this way at the same time, even 
if the list is very long. The column widths can be adjusted with the mouse.

5.6.1 Order Context Menu
The order context menu is opened by right-clicking within the order list. From 
this menu all options normally started by buttons can also be accessed.

Illustration 29: Order Menu

The individual functions will be explained in more detail in the following sec­
tions.

Actions in the Order Window and Order Context Menu:

The option "Create Backup Copy"  will,  after  confirmation,  create a backup 
copy of all images of an order, regardless of a batch operation (operation tar­
geting all images of an order). After the process has been carried out, every­
thing can be reversed if desired, or single images restored to their original con­
dition.

This option is not accessible through the order window with the order list, but 
only through the order context menu.

5.6.2 Selecting Orders for Editing
To select an order you wish to edit, simply click on the appropriate order with 
the left mouse button. The backdrop of a selected order will be colored in light 
yellow. Multiple orders can be selected by holding the SHIFT key and clicking 
with the mouse.
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5.6.3 Deleting Orders
Clicking the "Delete" button deletes the selected order after the deletion confir­
mation message is confirmed by clicking "Yes".

5.6.4 Creating a Multi-Page TIFF File
Clicking the "Multipage TIFF..." button creates a multi-page TIFF file from the 
currently selected order. A dialog window will open asking for the name and di­
rectory for the multi-page TIFF file. After the message is confirmed with "OK" 
the file is created in the target location.

5.6.5 Creating a PDF File (optional)
Requirement: BCS-2® PDF module

Clicking the "Generate PDF..." button creates a PDF file from the currently se­
lected order in the target directory (see chapter 5.5.5 page 29).

5.6.6 Transferring PDF Files from Target Directory
Clicking the "PDF Transfer..." button will open a window with options for trans­
ferring PDF files. This window displays all PDF files in the PDF target directory, 
which can be sent via e-mail, opened or deleted by selecting the desired file 
and pressing the appropriate button.

Illustration 30: Selection Window for Transferring PDF Files
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5.6.7 Publishing Orders Online (Web-Publisher) (optional)
To publish an order online, select the desired order from the order list and click 
the "WWW ..." button. This will transfer the selected order with the BCS-2® web 
publisher  with  the settings  defined  in  "WWW-Configuration" (see  chapter 
12.7 page 81).

5.6.8 Transferring Orders
Select the desired order or orders from the order list. Now clicking the "Trans­
fer..." button transfers all selected orders to the target directory defined in the 
order options. If the option "Delete Order after Transfer" is activated within the 
order options, the transferred scans will be deleted from the working directory. 
Scans  are  transferred  to  target  directory  together  with  the  "order.dat"  file 
(which describes the order) but without thumbnails. When transferring orders of 
the "Simple" Order-Type, no "order.dat" file is created.

5.6.9 Mailing Orders
To send the selected orders, click the "Mail To..." button. A message will appear 
asking if the order should first be saved as a multi-page TIFF file.  The advan­
tage of doing so is that only one file needs to be mailed. Once this selection 
has been made, the order, together with an automated mail containing relevant 
information (including indexes), will be transferred via MAPI to your e-mail soft­
ware.

Note: When converting JPEG files to a multi-page TIFF file, it is possible that 
the size of the multi-page TIFF file will become very large.

5.6.10 Despeckle2 Entire Orders
Clicking the "Despeckle" button removes impurities (“noise” of an image) for all 
images within the selected order(s).

Caution: If the scanned original was of bad quality, parts of the scan (ex. parts 
of text) can be removed unintentionally in this way.

5.6.11 Deskew3 Entire Orders
Clicking the "Deskew" button in the order list will cause all images within the 
selected order(s) to be optimally i.e. horizontally straight aligned.

2 Speckle is the "noise" within the image of a scanned document. Random single pixels (speckles) act as a fog layer 
decreasing image quality. The method for automatically removing speckles is called "despeckle".

3 Skew refers to a document being displayed at an angle after scanning. The method for automattically correcting 
this skew is called "deskew".
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5.6.12 Post Processing Orders (optional)
Requirement: BCS-2® Batch module

The "Post Process" button can edit entire orders with a series of image opera­
tions in a pre-defined sequence (batch operation).

The settings for the post processing mentioned above can be defined in the 
menu opened by clicking the "Configure Post Processing ..." button.

Illustration 31: Post-Processing Settings

 If active, the checkbox "Create Backup Copy before Batch Opera­
tion?" allows the undoing of batch operations for entire orders. If nec­
essary, this can be carried out by selecting the option  "Undo Batch 
Operation" in the "Edit" menu (see chapter 7 page 49).

 To insert an image operation into the list select an image operation 
from the dropdown list.

 Clicking either the "Insert before Current Position" or "Insert after 
Current Position" button will insert the new operation before or after 
the selected operation.

 To remove an image operation from the list, select the desired opera­
tion and click the "Delete Current Item from List" button.

 If the "Use Endorser as Last Operation ?" option is activated, the 
optional electronic endorser (see chapter  12.9 page 89) will be used 
on the images after all operations in the list have been completed.

 By checking the "Adapt Format at End ?" box the format of the im­
ages can be set after all other operations have been completed.
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 Clicking the "Configure Format Adaption..." button opens the win­
dow for the format adaption settings:

Illustration 32: Format Adaption

 "Target Format": The target format (still portrait) to which all im­
ages will be scaled can be set here.

 "Rotate Wide Images ?": If this option is checked, images will be 
turned to fit the target format if necessary. This option is recom­
mended to avoid compression when scaling images.

 "Adjust  Width/Height (in %)": The values of these fields deter­
mine the horizontal and vertical compression of the images.
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5.6.13 Background Post Processing (optional)
Requirement: BCS-2® Background module

The optional BCS-2® background module allows for simultaneous scanning of a 
new order and post processing of one or more previously scanned orders. To 
activate  this  function  check  the  "Perform  Selected  Operations  in  Back­
ground (if possible)" box (see screenshot in chapter 5.6 page 38) in the order 
list. Now batch operations can be conducted on one or more scan orders and a 
new scan order started while the operation is in progress. The "Background 
Monitor" display the post processing progress:

Illustration 33: Background Monitor

5.6.14 Duplicating Orders
The button "Duplicate Order" duplicates the selected order or orders. The or­
der number(s) of the duplicate(s) will be the continuation of the highest order 
number of the orders in the order list. This option is useful if you edit one or 
more orders but also want to keep the original version(s) of the order(s).
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5.6.15 Exporting and Importing Orders
Scan orders can be exchanged between different BCS-2® systems. The two op­
erations for exchanging orders are located in the order window with the order 
list:

 "Unload...": This button (or the corresponding point in the order menu) 
unloads one or more BCS-2®  orders as a ZIP file.

The ZIP file is recognizable as a BCS-2®-order-export file because it 
contains  a  file  named  "SIGNATURE".  Besides  noting  that  it  is  a 
BCS-2®-order-export file, the license number and version of the ex­
porting BCS-2® program are also saved with this file. This signature file 
allows the BCS-2® software to differentiate between a BCS-2®-order-
export file and a normal ZIP file.

 "Load...": This button is used to import previously exported (unloaded) 
orders into the BCS-2® software. After clicking the button, a file brows­
er will appear, with which the desired ZIP file needs to be selected. 
BCS-2® will then verify if the ZIP file is a proper BCS-2®-order-export 
file (see above) and then import the orders contained in the file.

5.6.16 Printing Orders
Clicking the "Print..." button will completely print all selected orders. Printed or­
ders are marked in the "Pr." column.
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6  F ILE  MENU

6.1 File Menu Basic Functions
 "Open": This option opens the usual window for opening files. Select 

the directory in the upper box and the file you wish to open in the low­
er box. If only files of a specific type are to be displayed, these can be 
selected  in  the  "File-Type:" dropdown  menu,  where  JPEG-,  GIF-, 
PNG- and TIFF files can be selected. To open complete orders, use 
the order list in the order window.

Button bar icon: 

 "Save": Saves the images of the current order in the directory defined 
in the file browser window. 

Caution: Multi-page TIFF files are not supported!

Button bar icon: 

 The option "Save As PDF..." will save single scans (the image current­
ly in the work area for the "Single" Order-Type) or entire orders direct­
ly as a PDF file. This menu point can also be accessed via the "PDF" 
button in the button bar.

Button bar icon: 

 For the "FTP-Browser ..." see chapter 6.2 page 47.

 "Mail To...": This option sends an image or order via e-mail (see chap­
ter 5.6.9 page 41)

Button bar icon: 

 "Print...": The current image is printed. If you wish to print an entire or­
der, you can do so using the order list (see chapter 5.6.16 page 45).

Button bar icon: 

 "Printer Output: Fix A4": If this option is active, output to the printer 
will always be in the A4 format.

 "Printer Output: Fix A3": If this option is active, output to the printer 
will always be in the A3 format.

 "Printer Output: Duplex": If  this option is active, the output will  al­
ways be on both front and backside (if appropriate printer is available).

 "Printer Driver defines  Output Format": If this option is active, the 
format set in the print driver will be used as the output format.

 The "Print Setup..." option lets you configure your printer.
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 "Print after Scan": If this option is activated each image is automati­
cally printed after it is scanned (Scan-to-Print). This function can also 
be activated by pressing the F9 key.

 "Rotate Wide Images for Print": If this option is active, images wider 
than taller are rotated by 90 degrees before printing.

 "Exit" : BCS-2® is closed.

6.2 FTP Browser
The "FTP-Browser ..." option starts the BCS-2® FTP browser.

Users knowledgeable  about  FTP,  will  quickly recognize the functions of  the 
BCS-2® FTP browser. It offers the options to select or look into an FTP directo­
ry, or download files.

Clicking the "Refresh" button will refresh the display of the respective directory.

Illustration 34: FTP Browser

 "FTP Server": The FTP server is ascertained here by entering the IP 
address or the hostname.

 "User": Enter the username here.

 "Password": Enter the password for FTP access here.

 "Select Folder":  Enter the target  directory on the FTP server here. 
The "Create" and "Delete" buttons let you –if you have writing rights 
on the server– create or delete folders.
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 "Download Folder": Enter the the directory you wish to download all 
files to (via FTP) here. The "Select" button lets you select the folder 
with the help of a browser window.

 "Connection Status": If an FTP connection is currently active it will be 
displayed here.

 "Transfer Type": In this area the type of the transfer can be chosen, 
either ASCII or binary. By default only the binary transfer type will be 
used, as the ASCII transfer type is mainly used for text.

 "Passive Mode (Firewall Mode)?": If you are having trouble estab­
lishing a connection to an FTP server, check this option.

 "Use SFTP ?": Checking this option will enable the secure data trans­
fer via "SSH File Transfer Protocol".

 "Connect": If no FTP connection is active, click here to start one.

 "Disconnect": Click here to disconnect an FTP connection.

 "Double-click to download": Checking this checkbox will cause dou­
ble-clicking on any file in the FTP directory for it to be downloaded to 
your download folder.

 "View Automatically after Download":  Checking this checkbox will 
display a downloaded file once it has been successfully downloaded.
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7  EDIT MENU
 "Undo": This option will undo (reverse) all editing functions from the 

current image. This option can also be activated by pressing the CTRL
+Z key combination.

 "Restore Image from Backup": If the option "Create Backup Copy" 
was used in the current  order,  selecting the "Restore Image from 
Backup" option will restore images in the order to their backup condi­
tion.

 "Undo Batch Operation": This option completely restores all images 
of an order to their condition before post processing, after they have 
been post processed. To be able to use this function the option "Cre­
ate Backup Copy before Batch Operation?", accessible after click­
ing the "Configure Post Processing ..." button in the order options di­
alog window, must be checked (see chapter 5.6.12 page 42).

 "Cut": Cuts current image into the clipboard. This function can also be 
activated using the key combination CTRL+X.

Button bar icon: 

 "Copy": Creates a copy of  the current image in the clipboard. This 
function can also be activated using the key combination CTRL+C.

Button bar icon: 

 "Paste": Inserts the image currently in the clipboard into the order be­
hind the selected image. This function can also be activated using the 
key combination CTRL+V.

Button bar icon: 
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8  ORDER MENU

8.1 Order Menu Basic Functions
 "Create...": Creates a new scan order (see chapter 5.4.1 page 19).

 "Close Current and Create New Order": Closes current order and 
creates a new order of the same Order-Type.

 "Select...": Opens the order window with the order list (see chapter 
5.6 page 38). Orders can be selected here for editing.

 "Import Image Files...": Imports all JPEG and TIFF files from a folder 
into the current order. (For the optional import of additional file types 
see chapter 13.8 page 98).

 "Options...": Opens the option dialog window (see chapter  5.5 page 
24).

 "Set Barcode Position...": Starts the process to set the barcode posi­
tions on the cover  sheet  of  an order.  This  process is  explained in 
chapter 5.4.6 "Setting Barcode Position" on page 22.

 "Edit Order Indexes...": Enables post editing of order indexes of the 
current order.

 "Edit Order Long-Text...": Enables the editing of a text for the order 
with the internal editor. The long-text of an order, for example a sum­
marized description of the current order, has no length limit and is writ­
ten into the "order.sum" file upon transfer. The order long-text corre­
sponds  to  the value  of  the BCS-2®  variables  "ORDER_TEXT" (see 
chapter 13.2 page 90).

In addition to the order long-text a  page long-text can be added to 
each page of an order, for example to describe each image of an or­
der. Pressing the  SHIFT+Space  key combination opens the internal 
editor with which the page long-text for the current image can be edit­
ed. This function cannot be accessed via the "Order" menu. The page 
long-texts are also written into the "order.sum" file upon transfer.

 "Information about the Order...": Displays an overview of the current 
order, containing Order-Type, order number, number of pages, date of 
last update and size. Also, the old order number and creation date are 
displayed if the order has been imported.

 "Rearrange Pages: Left Pages First":

Requirement for this function is an even number of pages within the 
order, and that all right-hand pages were scanned before the left-hand 
pages.

After confirming, and then performing this operation, all pages will be 
collated in the correct order.
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Caution: This operation can only be performed once per order, and 
cannot be reversed.

 "Rearrange Pages: Right Pages First": see above
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8.2 Pagination Functions
Pagination functions (page organization of a scan order) are managed in the 
"Pagination" section in the "Order" menu:

 "Up/Down One Level": Increases or decreases the pagination level of 
the image selected in the thumbnail list.

 "Reset All Levels": Resets all pagination levels of the current order.

 "Show Current Structure...": Opens an overview window, displaying 
the organization (pagination) of the current order:

Illustration 35: Example Pagination Overview

Hint: In the overview window (screenshot) the pagination levels can 
conveniently be increased or decreased by pressing the "+" and "-" 
keys (see also chapter 5.5.9 page 36). The desired page needs to be 
selected in the overview menu with a left-click.

Note: The setting numeration type of the organization level can be defined by 
clicking the "Pagination ..." button in the options dialog window (see chapter 
5.5.9 page 36).
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9  V IEW  MENU

9.1 Adjustment Functions
The "View" menu contains five functions to facilitate working with images in the 
work area, especially when working with large images.

 "Original Size": The image is displayed in its original size. Every cap­
tured pixel is shown, so the display of the image may be quite large.

Button bar icon: 

 "Fit to Width": This function will enlarge the image or make it smaller 
to exactly fit the width of the window. The proportion (aspect ratio) of 
the image is preserved. If the size of the window is changed, the im­
age will adapt accordingly.

Button bar icon: 

 "Fit to Height": This function will enlarge the image or make it smaller 
to exactly fit the height of the window. The proportion (aspect ratio) of 
the image is preserved. If the size of the window is changed, the im­
age will adapt accordingly.

Button bar icon: 

 "Fit to Window": This function fits the image to height and width of the 
window.

Button bar icon: 

 "Maximize Window Automatically": If this function is active, the win­
dow is always maximized on the desktop. This option can be very use­
ful and its use is recommended.

9.2 Zoom Functions
Zoom functions enable you to enlarge certain sections of an image, or make 
them appear smaller:

 "Zoom In": Zooms in/closer on the image, largely displaying a small 
section of the image.

Button bar icon: 

 "Zoom Out": Zooms out/away from the image, displaying more of the 
image, making the depiction appear smaller.

Button bar icon: 
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The "Zoom in" and "Zoom Out" functions can also be accessed via the context 
menu by clicking the right mouse button. If  you only wish to enlarge a specific 
region of  the image,  mark it  and the program will  automatically display the 
marked region for you.

9.2.1 Scrolling and Zooming with the Mouse
Images in BCS-2® can also be moved via the mouse, i.e. scrolled. This means 
the image is moved up/down or left/right in order to see different sections of the 
image. You can also zoom in and zoom out of an image.

Turning the mouse wheel will vertically scroll the image. You can also scroll hor­
izontally if you hold the SHIFT key while turning the mouse wheel.

Holding the CTRL key will zoom in and out of an image, depending on which 
way the mouse wheel is turned.
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10  IMAGE MENU

10.1 Operations after Scanning
"Automatic Operations  after  Scanning"  is  the  first  option  in  the  "Image" 
menu.  If activated, the operations within this menu point are performed auto­
matically after scanning. Clicking any of the options once will activate the se­
lected operation. Active operations are marked with a checkmark in front of the 
operation name. Clicking an active option will disable it and remove the check­
mark.

The operations listed below, in the order they appear in the menu, can be auto­
matically performed after scanning:

 Invert

 Mirror Horizontally

 Deskew

 Despeckle

 Black Border Removal

 Rotate Image 90 degrees (clockwise)

 Rotate Image 180 degrees

 Rotate Image -90 degrees (counter-clockwise)

Illustration 36: Sub-Menu Operations 
after Scanning in the Image Menu
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10.2 Rotation Functions
Should a scan not be oriented as desired, this can be corrected in the "Image" 
menu.

Rotating images after they have been scanned is done with the following func­
tions:

 "Rotate: 90°": The image is turned to the right by 90 degrees.

Button bar icon: 

 "Rotate: -90°": The image is turned to the left by 90 degrees.

Button bar icon: 

 "Rotate: 180°": The image is turned "upside down".

 "Rotate: 10°": The image is turned to the right by 10 degrees.

 "Rotate: -10°": The image is turned to the left by 10 degrees.

 "Rotate: 1°": The image is turned to the right by 1 degree.

 "Rotate: -1°": The image is turned to the left by 1 degree.

These functions can be undone by using the "Restore Image" option, the last 
option in the "Image" menu.

10.3 Text Recognition Functions (optional)
Requirement: BCS-2® OCR module and BCS-2® OCR engine

BCS-2® optionally offers text recognition functions.  The "Image" menu offers 
the following options:

 "Perform OCR4...": Performs text recognition on the current image.

 "OCR: Drag Zone with Mouse": A desired area in which text recogni­
tion is to take place can be selected with the mouse.

 "Select OCR Language...": Select the language of the document on 
which you wish to perform text recognition. Selecting the proper lan­
guage will increase the recognition rate.

For the OCR settings see chapter 13.9 page 98.

10.4 Special Functions
The "Image" menu also offers special functions to conveniently increase the 
quality of scanned images.

4 Optical Character Recognition. A procedure to recognize text information from scanned documents.
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 "Grayscale": This function has no effect on the image file. It will how­
ever greatly improve the display quality of the image by softening hard 
contrast edges with graytones. Quality may be reduced at very high 
zoom levels. (Hotkey: F8)

Button bar icon: 

 "Despeckle": Small points (Impurities) on the image are automatically 
removed. It is recommended you use this function only on bitonal 
(black and white, 1 bit per pixel) images. (Hotkey: F6)

Button bar icon: 

 "Deskew": The image is properly aligned automatically.
(Hotkey: F7)

Button bar icon: 

 "Invert": Image colors are inverted. 
(Hotkey: SHIFT+F6)

 "Flip Horizontally": The image is flipped horizontally.

 "Flip Vertically": The image is flipped vertically.

 "Whiten Black Borders": Whitens out the black border surrounding a 
scanned image.

Button bar icon: 

The menu point "Restore Image" in the "Image" menu will  completely undo 
any of  these functions. This function corresponds to the "Undo" point in the 
"Edit" menu, and can also be performed by pressing the CTRL+Z key combina­
tion.
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 "Configure Black Border Removal...": The settings for the black bor­
der removal  can be configured here. Best  results are attained with 
bitonal images.

Illustration 37: Black Border Removal Configuration

When using the black border removal  tool  on bitonal  images,  you have the 
choice of using either the LeadTools function or an alternative algorithm. To use 
the  LeadTools  function,  the  "use  LeadTools Function"  option  must  be 
checked. The LeadTools function will result in the best results for most images.

Following parameters can be defined for the LeadTools function:

 "Search depth in any direction": Admissible values are 1...100. This 
value determines the percentage of the dimension, in every direction, 
within the image the threshold from black to white is searched for. The 
default value is 45%, meaning in every direction, 45% of the image are 
searched for an edge.

 "Noise allowed": This parameter defines how much noise is allowed. 
Admissible values are 1 through 10, the default value being 10, mean­
ing noise is allowed.

 "Edge Variance": This parameter defines the variance permissible in 
the form of the edge. Admissible values are 1 through 10, the default 
value being 10, meaning a large variance is allowed.
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Following parameters can be defined for the internal function:

 "Threshold for  bitonal/Grayscale/Color": Brightness-values  be­
tween 0 (black) and 255 (white) from which the algorithm defines the 
threshold for the transition to white.

 "Number of pixel for smoothing": This value defines the number of 
average pixels for checking the threshold.

 "Stepping in Pixels": This number defines the accuracy of the analy­
sis: for example, a value of 10 means a test is performed every 10 
rows. The ascertained value is then applied to that row as well as the 
nine rows before it.
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10.5 Page Splitting and Masking

10.5.1 Manual Page Splitting
Manual page splitting splits images at a desired location after they have been 
scanned.

Illustration 38: The Page Splitting Function

This mode is activated by selecting the "Toggle Manual Page Splitting" option 
in the context menu (right-click) or via "Page Splitting and Masking" → "Tog­
gle Manual Page Splitting" in the "Image" menu.

For quick access the F11 key can be pressed, or the appropriate button in the 

button bar:  

In the page splitting mode a red splitting-line can be moved over the image. To 
move the splitting-line to the left or right move the mouse cursor over the red 
line. The cursor will change to a double headed arrow. Holding the left mouse 
button now will allow the splitting line to be moved.

Selecting the "Split Page/Apply Mask" option will perform the page splitting at 
the appropriate position. The old image is discarded and two new images are 
created: the left and right sides. When the splitting-line has been set, the page 
splitting can also be performed by pressing the ENTER key.
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Optionally the middle section of the original image can be cut out, for example 
to remove the shadow of a book crease. For this purpose an inner margin can 
be set. This function is accessed via the "Toggle Manual Page Splitting with 
Inner Margin" option in the "Image" menu or via the context menu (right click). 
The red line is the left border, and the right border is visible as a blue line, both 
movable with the mouse cursor. The area in between the two lines (see screen­
shot below) will be discarded when the function is performed.

Illustration 39: Page Splitting with Inner Margin

When page splitting is performed, the image will be split into the part from the 
left image border to the splitting line (red), and from the splitting line (blue) to 
the right image border. The page splitting mode can be exited by pressing the 
"R" button, removing the page-splitting line.
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10.5.2 Mask Mode
In the mask mode, an area of an image is defined that will become the new im­
age after the mask is applied. The basic idea is always obtaining the same area 
of an image when scanning a large number of documents, for example micro-
fiches. Page splitting can also be performed simultaneously if desired.

Illustration 40: The Masking Function

The mask mode is started by selecting the  "Toggle Mask" option in the "Im­
age" menu or the context menu.

To use both a mask and page splitting simultaneously, select the option  "Tog­
gle Mask with Splitting Line". If you also wish to remove a book crease shad­
ow, select the "Toggle Mask with Inner Margin" option.

To change the size of the mask, position the mouse cursor on a line of the 
mask you wish to resize and “pull” into the desired size and shape by holding 
the left mouse button.

When clicking and holding the left mouse button inside of a mask-tile the entire 
mask can be moved.

After performing the operation by selecting the "Split Page/Apply Mask" option 
or pressing the  Enter  key,  the image will  be replaced by the content of  the 
mask.  If  a  page-splitting line was also active ("Toggle Mask with Splitting 
Line"),  the content of the mask will  additionally be split  into the defined two 
parts. The left and right borders of an inner margin ("Toggle Mask with Inner 
Margin")  can also be defined for removing book crease shadows.

10.6 Multi-Masking (optional)
Requirement: BCS-2® Multi-Masking module with Thumb Removal
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BCS-2® also offers the possibility of defining multiple rectangular masks for a 
certain scan format (format, color depth, orientation). These tiles (see screen­
shot below) can be transformed into new images or have their content replaced 
with the contents of another mask.

Illustration 41: The Multi-Masking Function

This function is accessed by selecting the option "Multi-Masking" → "Activate 
Multi-Masking" in the "Image" menu, or alternatively simply selecting "Acti­
vate Multi-Masking" in the context menu.

Button bar icon: 

Illustration 42: Multi-Masking Context Menu

Note: If Multi-Masking is active, pressing the right mouse button will open the 
context menu pictured above.
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Multi-Masking Procedure:

 If Multi-Masking is active, multiple mouse-movable masks (tiles) can 
be  created  by mouse "pulling".  The individual  mask  tiles  are  num­
bered.

Illustration 43: Multi-Masking Sub-Menu in the Image Menu (or 
Context Menu)

Note: BCS-2® saves the tile positions. This will facilitate your work if 
you wish to scan and cut/fragment a number of documents within the 
same order in the same way, as you do not need to create the different 
masks again for each scan.

 After all  masks have been placed as desired,  you can perform the 
Multi-Masking function by pressing the  ENTER key or selecting the 
"Apply Multi-Masking"  menu point.  Each mask will  then  be trans­
formed into a new image and the original image is discarded. The new 
images are inserted into the order in place of the old image, their se­
quence corresponding to the numbers of the tiles.

 Additionally you can differentiate between the "Apply Multi-Masking 
Automatically after Scanning" and "Apply Multi-Masking Automat­
ically before Next Scan" functions.

 The option "Keep Original Scan after Multi-Masking" will allow you 
to keep the original image. The newly generated images will then be 
inserted into the current order behind the original image.

Note: Upon installation, this option is activated by default.

 You can also save your  chosen Multi-Masking configuration ("Save 
Current Configuration...") or "Load Saved Configuration...".

 The menu point "Delete All Tiles" will  make BCS-2® delete all  tiles 
and their corresponding positions.

10.6.1 Multi-Masking Details
The individual  tiles can be edited and moved after  having been created by 
"pulling". To do so left click on the tile you wish to edit, which will highlight the 
frame of the selected mask:
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unselected tile  → selected tile

To change the size of the mask, position the mouse cursor on a line of the 
mask you wish to resize and “pull” into the desired size and shape by holding 
the left mouse button.

When clicking and holding the left mouse button inside of a mask-tile the entire 
mask can be moved.

Right clicking on a selected tile will open a special context menu with more op­
tions and functions.

Illustration 44: Selected Tile 
Context Menu

Functions of the Selected Tile Context Menu:

 "Duplicate tile left/right/up/down": A selected tile can be duplicated 
to the right, left or up and down as long as sufficient space in the cho­
sen direction is available on the image. An identical tile will be created 
bordering the selected tile in the chosen direction. This function can be 
performed consecutively in different directions.

 The option "Assign format" defines a fix standard format (A3, A4, A5 
oder A6) for the selected tile.

 Individual tiles can be deleted by clicking the "Delete tile" option. The 
numeration of the tiles will change accordingly.

 Performing the Multi-Masking operation is also possible here ("Apply 
Multi-Masking").
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 Selecting the "Properties..." menu point will open the following dialog 
window:

Illustration 45: Tile Properties

Among other properties, the  "Name" and  "Description" of a tile can 
be defined here.

Also, the "Number" of any given tile can be edited, giving you control 
over the sequence of the tiles.

A "Reference Tile" can be set, which will replace the contents of se­
lected tiles with the contents of the reference tile. 

Note: For both the reference tile and the tile you wish to replace, the 
property "Tile is inner tile" must be activated. Additionally the check­
box "Save image" must not be checked.

You can also select which other operations to perform when applying 
the Multi-Masking function:

 "Adapt Color Depth": If the image being edited is in color, the tile 
can be saved in bitone or grayscale. The color diffusion algorithm 
can be defined as desired.

 By default the file format is automatically assigned. If desired the 
file format can be manually defined in the "File Format:" area.
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 ORC information  and  barcodes  can  also  be  transferred  in  be­
tween tiles. For example, tile 5 is the reference tile for tile 1. Now 
checking the "Recognize barcode" checkbox will set the barcode 
of tile 5 into tile 1. The checkbox "Save image" is unchecked for 
tile 5.

 Clicking the "Configure Further Image Operations"  button al­
lows more operations to be performed such as deskew, despeck­
le, black-border-removal, etc.
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10.6.2 Thumb Removal via Multi-Masking
With BCS-2® it is also (optionally) possible, to automatically remove thumbs that 
typically appear when using overhead scanners.

The three Thumb Removal steps:

 Start a new order and create a scan on which the thumbs (right and 
left) appear.

Illustration 46: Scan with Left and Right Thumbs

 Activate Multi-Masking. The quickest way is by clicking the appropriate 

button in the button bar:  
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 Define two tiles. One tile encasing the thumb (left) and the second 
without a thumb (the contents of the second tile will replace the con­
tents of the first tile).

Illustration 47: Defining Tiles

 Next, activate the first tile (tile 1) with a left click. Now right click on tile 
one to access the selected tile context menu. In the  "Properties..." 
window do the following:

 Set tile 2 as the reference tile.

 Uncheck the "Save image" box.

 Check the "Tile is an inner tile" box.

 Now  click  the  button  "Replace  Tile  Contents  (Thumb 
Removal)...". In the dialog window that appears, check the "Acti­
vate Thumb Removal" box and the "Use contents of reference 
tile for filling" box.

Illustration 48: Activating Thumb Removal

 Now activate tile 2 with a left click. In the "Properties..." menu of the 
tile, check the checkbox "Save image".
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 Now define a third tile (tile 3) over the right thumb. For tile 3 define the 
same properties as for tile 1.

 The thumb removal process can now be performed by either selecting 
the  "Apply  Multi-Masking"  option  in  the  context  menu,  the  corre­
sponding option in the "Image" menu, or by pressing the ENTER key.

The contents of tile 2 (the reference tile) will now be inserted into tiles 
1 and 3, and consequently the thumbs disappear.

Note: To  perform  thumb removal  automatically  together  with  page 
splitting or masking, deactivate Multi-Masking (ex.: with the button in 
the button bar) and select the "Perform Thumb Removal when Split­
ting/Masking" option in the sub-menu "Page Splitting and Masking" 
in the "Image" menu.
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10.7 Imagetools
The BCS-2® Imagetools offer various image editing operations for scanned doc­
uments. The image tools can be accessed either by selecting the "Show Im­
agetools" option in the "Image" menu or clicking the "Show Imagetools" op­
tion in the  "Image Edit Context Menu" (see chapter  4.4 page  14). Selecting 
this menu point again, or clicking the "X" in the title bar of the Imagetools will 
hide the Imagetools again.

Imagetools
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- Cuts out selected area and moves it to clipboard

- Moves the image within the window

- Whites out around selected area

- Whites out within the selected area

- Recognizes a barcode within selected area

- Performs text recognition in the selected area

- Toggels Multi-Masking funktion

- Copies selected area to the clipboard

- Increases brightness

- Decreases brightness

- Decreases contrast

- Undoes last action

- Increases contrast

- Applies changes

- Zooms in on selected position

Button Functions:



11  SCANNER MENU

11.1 Selecting a Scanner
Caution: The scan mode (see chapter 11.2 "Scan Mode") will have to be cho­
sen before a scanner can be selected.

A scanner can be quickly and easily selected via the "Select a Scanner..." op­
tion in the "Scanner" menu. If multiple suitable scanners are installed on the 
system, the desired scanner you wish to use for working with  BCS-2® can be 
selected, or for the network mode the name and IP address entered.

BCS-2® will load the necessary drivers and search for scanners. After a short 
while a window with a list of available scanners will appear. Select the desired 
scanner with a left click, and confirm your selection with the "OK" button.

11.2 Scan Mode
BCS-2® also offers the possibility of connecting a scanner via  HiScan5 port, 
Network,  TWAIN,  ISIS or  SCSI. To do so, the appropriate mode needs to be 
activated in the "Scanner" menu with a left click.

The necessary driver needs to be installed in order to connect a scanner via 
HiScan, TWAIN, ISIS oder SCSI.

If you select the "Use TWAIN/ISIS Interface" menu point, you can scan from 
the interface of the scanner or scanner driver and adjust scanner specific prop­
erties within BCS-2®.

The option "TWAIN: Always Send Settings to Scanner"  will  make BCS-2® 

send the set properties to the scanner before each scan. This may be neces­
sary for some TWAIN scanners.

11.2.1 Settings for Bookeye® Family Scanners
If the  network mode is active, the option "Network  Scanner Settings..." will 
open a window with special settings for Bookeye® family scanners. Among other 
settings you can determine: file format (JPEG or TIFF), the document mode 
(flat, folder, book), page splitting, the search area when auto-formating and the 
gamma value. This window also displays the firmware version and serial num­
ber of the network-connected Bookeye® family scanner.

5 Scanner Interface Card. Developed for quick document transfer including real-time data compression into an image 
editing software.
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Illustration 49: Network Scanner Settings

In the "Auto-Exposure" area the Auto-Exposure mode of a network connected 
Bookeye® family scanners can be activated. Two operating ways are supported: 
The first  turns all  pixels below the threshold value black  ("Draw to Black"), 
while the second ("Recompute in Image") examines and adjusts the image.

Clicking the "Autofocus Control ..." button opens the "Autofocus Settings":

Illustration 50: Autofocus Settings

In the "Autofocus Mode" you can choose one of three settings:

 "Autofocus always on"

 "Fix autofocus on baseplate": This setting can be useful when using 
a book holder.
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 "dynamic Autofocus": When checked this checkbox activates the dy­
namic autofocus. This setting will turn off the autofocus function before 
each scan. In this way the dynamic autofocus can greatly accelerate 
the work while scanning. With the further settings for the dynamic Aut­
ofocus you can adjust function details:

 "Timeout in Seconds for next Autofocus": Here the time inter­
val is defined, how long after each scan the autofocus function is 
performed.

 "Number of scans with same focus": The number of scans per­
formed with the same focus can be set here.

The menu point "Network Scanner Web-Interface..." in the  "Scanner" menu 
opens the web interface of a scanner, where additional settings can be adjust­
ed.

11.3 Scanning from the Scanner Menu
You can start scans from within a scan order by selecting the "Scan" option in 
the "Scanner" menu, or alternatively by pressing the key combination CTRL+S.

Activating  the  menu point  "Acoustic  Signal  before  Scan"  will  cause  scan 
readiness to be indicated with an acoustic signal.

11.4 Selecting Color Depth
With the "Color Depth" menu point you can choose to scan in black and white 
(bitonal), in grayscale (4/8 Bit), in the photo mode (see below) or in color. The 
possible settings depend on the scanner being used. The "Improved Bitonal 
Interpolation" is only relevant for Bookeye® 1 type scanners, and only accessi­
ble directly in the "Scanner" menu.

11.4.1 Photo Mode
"Photo Mode" is a special black and white mode for certain Bookeye®  family 
scanners. Scanning occurs bitonal, but the quality of the scanned image is “im­
proved”  through error diffusion (dithering),  avoiding hard transitions between 
light and soft areas.

11.5 Scan Quality Settings
BCS-2® can manage four different brightness and contrast combinations. These 
combinations are saved into individual scan quality levels and can be accessed 
via the "Scan Quality-Levels" option in the "Scanner" menu. The settings for 
the  different  quality  levels  can  be  adjusted  with  the  "Set  Scan  Quality-
Levels ..."  menu point.
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11.6 Bookfold Correction 
Selecting the "Bookfold Correction" option in the "Scanner" menu will auto­
matically remove the shadow of the curvature of the bookfold.

Caution: This function is only available for Bookeye® family scanners!

When using the BCS-2® bookfold correction function, it is necessary the book 
being scanned is placed about 5 cm away from the bottom border on the scan 
area, toward the Bookeye® scanner neck.

For more detailed settings for bookfold correction, select the  "Bookfold Cor­
rection Settings..." option in the "Scanner" menu.
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11.7 Defining Userformat
The "Define Userformat..." option allows the scanning of only a defined select­
ed section of the scan area. This function is only available with Bookeye® family 
scanners and some ISIS scanners. If this function is active, first the entire scan 
area is scanned, and the userformat section is then defined with the mouse.

Illustration 51: Defining Userformat Function

To be able to scan the defined area, the option "User defined" must be activat­
ed in the page format dropdown bar.
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11.8 Scan Front and Backside (ISIS)
The "Scan Front- and Back-Side" option in the "Scanner" menu is only avail­
able for ISIS mode scanners with an automatic and duplex capable document 
feeder. If this option is active, both the front- and back-page of documents will 
be automatically scanned.

11.9 Microfilm Settings (optional)
Requirement: corresponding BCS-2® modules

The "Microfilm Settings" option in the "Scanner" menu opens a window with 
multiple settings for microfilm scanners.
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12  EXTRAS MENU

12.1 Importing a License File
This option is used for importing license files (*.liz)  provided by ImageWare 
Components which allow unrestricted use of the BCS-2® software with all the 
chosen options. Selecting this function will open a dialog window in which the li­
cense file is selected. If the license is valid a confirmation message will appear. 
Should this not be the case, a message why the license is not valid will appear.

12.2 Check License
This option informs you if a valid license exists for the BCS-2® version in use. 
For  more  information  see  the  menu  point  "About  BCS-2®..."  in  the  "Help" 
menu.

12.3 Perform / Change Software Registration
In order for ImageWare Components to create a license file, information about 
the system you wish to use the BCS-2® software on is required. The "Perform/ 
Change Software Registration..." option launches a wizard that will guide you 
through the necessary steps and generate a licensing formula (see chapter 3.5 
page 9).

12.4 Language Selection
You can select the language you wish to use BCS-2® in with the "Select Lan­
guage" option in the "Extras" menu. In this way you can also change the lan­
guage of the program if you so choose. Some messages will however always 
appear in the installation language.
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12.5 Additional  TIFF Tags (optional)
The "Additional TIFF Tags..." dialog allows the definition of TIFF tags. These 
are then implemented into the image files of an order, and created upon trans­
fer.

Illustration 52: Additional TIFF Tags

The values displayed next to the tags in parentheses represent the ID of the 
corresponding tag.

Checkbox activated tags:

 "Pagename (285)": This options sets the tag with the ID 285 the same 
as the file name, the format can be adjusted in the input box.

 "Date-Time (306)": This option sets the tag with the ID 306 into the 
"YYYY:MM:DD HH:MM:SS" format.

A tag is only saved when the order is transferred. The values of the tags are 
also implemented at this time, so if the values of a tag have been changed in 
between creation and transfer, the latter values will be used.

BCS-2® variables can be inserted into the input boxes of the tags with the cor­
responding BCS-2® variable button (see chapter 13.2 page 90).
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12.6 Münzer/SmartCardReader (optional)
Requirement: corresponding BCS-2® PPC modules

A variety of  fee devices can be connected to the BCS-2® software to account 
for scans. Settings for such devices, the prices and ports, can be adjusted in 
the appropriate points of the "Extras" menu.
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12.7 Web-Publisher (optional module)
The BCS-2® Web-Publisher and FTP module can publish scan orders directly 
into the Internet or upload them to an FTP server from the BCS-2® software. 
Scan orders can also be deposited locally as a website. In this way scanned 
documents can be  easily  spread,  published and viewed by the recipient.  A 
thumbnail list with preview images eases navigation of published orders for the 
viewer.

Selecting the menu point "Web-Publisher-Settings ..." opens a dialog window 
to manage the Web-Publisher configurations.

Illustration 53: Web-Publisher Configuration Dialog Window

The Web-Publisher allows you to comfortably manage multiple "WWW-Config­
urations". The individual configurations are displayed in a list in the dialog win­
dow.

Following options:

 Set as Active, i.e. activated (filled in with green in above screenshot),

 New configurations created (individual name can be entered),

 Edit and Rename,

 Apply on Order,

 Duplicate,

 Delete,

 Import and Export (optionally via e-mail)

can be carried out.

Caution: The BCS-2® Web-Publisher is a very complex tool. The large function­
al range brings with it (depending on demand) its own amount of work for the 
configuration. Pre-existing knowledge in HTML and CSS etc. are requirements 
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for creating and adjusting an individual  "WWW-Configuration". The following 
section clarifies the most important steps of creating and editing a configura­
tion.

12.7.1 Creating and Activating WWW-Configurations
To create a "WWW-Configuration", click the "New..." button. Next, a name for 
the configuration can be entered.

Illustration 54: Entering a Name for a New "WWW-Configuration"

After the name has been entered into the input box, confirm with "OK". The new 
configuration now appears in the configurations management dialog window of 
the Web-Publisher.

To activate your configuration, select it and click the button "Set as Active".
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12.7.2 Editing and Adjusting a WWW-Configuration
To edit and adjust a "WWW-Configuration", select the appropriate configura­
tion in  the configurations management dialog window of  the Web-Publisher, 
and click the "edit ..." button. All configuration settings can be accessed in the 
main options dialog window that appears.

Illustration 55: "WWW-Configuration" Settings

 A label for the "WWW-Configuration" can be entered into the first in­
put box. 

 In the "Upload to server" area all settings for configuring the "upload 
mode" can be adjusted. Whether an order is saved locally or on an 
FTP or SFTP server can be defined here. The corresponding target di­
rectories and access data (username and password) can also be en­
tered or selected.

The  "Browse  FTP-Server..."  button  opens  the  FTP  browser  (see 
chapter 6.2 page 47).

The button "FTP Test" can be pressed to test the connection.

 In the "Web-Server" area the name or IP address of the desired serv­
er can be entered. The Port and Protocol (http, https etc.) as well as 
the "Main Folder (URL)" can also be defined here.

The "HTTP Test" button tests the connection.

 Name patterns for target folders and file names can be defined in the 
"Name of Target Folder" area.
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Illustration 56: "Name of Target Folder" Area

The names can also be encrypted and the name length fixed. This 
function is activated by checking the "encrypt name" checkbox.

 Multiple image options can be activated in the "Image-Options" area:

Illustration 57: "Image Options" Area

These options deal mainly with settings for the "Preview Images" and 
thumbnails.

The "upload OCR data ?" box determines if text recognition data is 
also uploaded. The file extension (ocr, txt oder dat) can be defined.

 Two options that can be activated and deactivated via checkbox are 
available in the "After Upload" area.

The browser  is  opened  after  each  scan  to  check  the  order,  if  the 
"show in Browser after successful upload ?" option is active.

HTML generation  can  be  de-/activated  with  the  "generate  HTML" 
checkbox.  Deactivation  needs  to  be  confirmed  with  a  confirmation 
message,  as uploaded orders cannot be viewed in a  web browser 
when this option is deactivated.

In addition to the clarified areas, three buttons for editing a "WWW-Configura­
tion", can be found in the main dialog window. Each opens an individual config­
uration dialog window.

Illustration 58: Additional Buttons

 "Email-Settings ...": In the dialog window opened when pressing this 
button, the e-mail notification received after a successful upload to a 
server can be edited. The checkbox "send eMail after upload" deter­
mines if an e-mail is sent after each upload. The settings for sending 
of the e-mail, either directly using SMTP or MAPI, can also be adjust­
ed here:
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Illustration 59: Web-Publisher E-Mail Settings Sub Window

Selecting  the  "use  SMTP"  option  activates  the  BCS-2® function  of 
sending  mails  via  an  SMTP server,  which  can  be  defined  in  the 
"SMTP-Notification" area. If this is not the case the mails will be sent 
via MAPI, the "use MAPI" checkbox.

The  "Subject"  and  "Body"  of  the  e-mail  can  be  (if  desired  using 
BCS-2®  variables) pre-defined. The  "Test" button generates a test e-
mail (only when using MAPI).

The e-mail recipient and if desired an e-mail copy recipient can be en­
tered via the input boxes, or be prompted for each time a mail is sent 
(only for  SMTP) with the "ask for Recipient everytime ?" checkbox.

 "PDF/ZIP/MTIFF/Meta ...": In the dialog window opened by this button, 
multiple settings for the creation of PDF-, ZIP-, multi-page TIFF- and 
meta text-files can be adjusted. If desired, all four file types can be 
created simultaneously. A corresponding file type is then created per 
order.

The creation of the individual files can be activated, as well as the file 
names pre-defined in the input boxes (if  desired using BCS-2®  vari­
ables), in the corresponding areas in the dialog window. Furthermore 
specific options such as the fixation of the number of pages for a PDF 
file can be adjusted.

The following screenshot shows the dialog for the settings for creating 
the different files:
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Illustration 60: PDF/ZIP/Multi-TIFF Settings Sub Window

Note: Especially the creation of the meta file can be an important sup­
port tool when processing data via  third party systems. Typically an 
XML file or a CSV file is generated here.

 "HTML-Settings ...": In this dialog window the HTML templates of the 
web publisher can be edited.

Illustration 61: HTML Settings Sub Wndow

 The individual components making up an HTML page can be edit­
ed and adjusted in the "edit HTML-template" area. After selecting 
a  template  from  the  list,  the  template  can  be  edited  with  the 
BCS-2® internal editor by clicking the "Edit" button. The previous 
condition of a selected template can be restored by clicking the 
"restore old" button.
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 The  "expert-mode"  (checkbox)  in  the  "edit  HTML-template" 
area, allows for more detailed HTML template editing. Either a ta­
ble-based layout or a list-based layout can be selected.

 Furthermore, additional images (logos) can be implemented. The 
corresponding options can be found in the "additional files to 
upload"  area.  These  images  are  saved  in  the  corresponding 
"WWW-Configuration" and can later be uploaded automatically.

 Also,  "further  settings"  can  be  adjusted  with  the  appropriate 
checkboxes in the corresponding area.

 The button "show in Browser ..." can display the current "WWW-
Configuration" in the standard web browser.

 The "apply on order" button "publishes" the order, if one is open, 
according  to  the current  "WWW-Configuration".  This  button is 
equivalent to the button in the configurations management dialog 
window of the Web-Publisher.
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12.8 XPrint Settings and Actions (optional)
Requirement: BCS-2® PPC-Module for XPrint-Server

Optionally, for simultaneous order printing and charging of print orders via chip-
card, BCS-2® can be connected to XPrint server systems. In the menu point 
"XPC..." the corresponding settings and actions can be adjusted in the appro­
priate sub-menus:

Illustration 62: "XPC ..." Sub-Menu in the "Extras" Menu
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12.9 The Electronic Endorser (optional module)
The electronic endorser can blend text labels and/or images into scans. For ex­
ample,  this option is useful if  a company logo is to be added to images, or 
source certifications integrated into the scans. The information can be integrat­
ed into the image, or placed on a side. The endorser is configured with the 
"Electronic Endorser..." option in the "Extras" menu.

Illustration 63: Electronic Endorser Configuration

 "Endorser Selection": Endorsers, added via the "New Endorser" but­
ton can be selected here.

 "Delete Endorser": Deletes the currently selected endorser.

 "Text-  or  Graphics  Mode":  Differentiate  between  text-  or  graphic-
mode.

 "Mode":  The selected endorser is activated here. Choose if  the en­
dorser is to blend into images or be added on the sides. The side on 
which the endorser is added can also be selected.

 "Text Mode": The text that will blend into the image can be defined in 
the "Text Mode" row. The box below displays a preview of the en­
dorsement.

 "Font...": Opens a window for setting font type, font size, display type 
and color.

 "Position": Determines the position of the endorser image.

 "Graphics  Mode":  The  image  file  (JPEG,  TIFF,  PNG and  GIF)  to 
blend into the scanned image can be selected here.

The endorser is turned on and off with the "Activate Endorser" option in the 
"Scanner" menu or with the CTRL+E key combination.
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13  ADMINISTRATION MENU

13.1 User Administration
The "Set BCS2 User..."  option in  the "Administration"  menu creates user­
names in the form of name abbreviations.

Illustration 64: Entering User Abbreviation

If  the  "Prompt  for  BSC2-User  on  Startup..."  option  is  active,  BCS-2® will 
prompt for a user at system launch.

Note: The username is stored in the variable "APP_USER".

13.2 BCS-2® Variables
At multiple places in BCS-2®, program-internal user-defined variables can be in­
serted, and will expand (designated value of a variable is inserted at the de­
fined position) when used. Variables can be used for example for the naming of 
files, etc.

Note: The use of variables is especially recommended for advanced users.

To use a variable, a $-symbol must precede it. In order for BCS-2® to recognize 
when the name of the variable is finished, the following symbol must come after 
the name:

1. blank (X'32', space): This is the default, the space will be retained after the 
expansion.

The variable APP_USER has the value John

Text in the input field: "$APP_USER is the username"

After expansion: "John is the username"

2. Another $-symbol: To make the strings (symbol-chains) connect.

Example:

The variable APP_USER has the value John

Text in the input field:"[$APP_USER$] is the username"

After expansion: "[John] is the username"
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13.2.1 Quick Access to the Variables
The "BCS-2 Variables..." button can be encountered in many places within the 
BCS-2® program. After selecting an input box, the BCS-2® variable selection 
can be started by clicking the variables button:

Illustration 65: Variable Selection

Now a variable to be inserted into the input box can be selected from the list. A 
double-click or clicking the "Apply" button will place the variable at the cursor 
spot in the input box. Multiple variables can be inserted in this way.

Within  the variable selection,  the category and description of  each selected 
variable will appear.

Note: A complete list of the BCS-2®  variables can be called up via the menu 
point "Documentation of System Variables..." in the "Help" menu (see chap­
ter 15.1 page 100).
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13.2.2 Administration of the Variables
The administration of the BCS-2® variables (the composition and querying) can 
be accessed in the "Administration" menu with the "BCS-2 Variables..." op­
tion.

Illustration 66: Variable List

The current values and descriptions of the individual BCS-2® variables are dis­
played here. It is possible to define custom variables. These user-defined vari­
ables can have their own value and description.

To have the current value of a variable displayed, click on the system- or user-
defined-variable or select the desired variable with the Arrow keys. The corre­
sponding value and description will appear in the boxes below the list.

Example:

A username is set with the "Set BCS-2 User..." option in the "Administration" 
menu by entering the abbreviation "John".

If the system variable  "APP_USER" is now selected in the variable selection 
list, "John" will be displayed as the value of the variable.
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Creating a User-Defined Variable:

To create a user-defined variable, click the "New" button. Now enter the name 
and description of the variable to be created.

The variable will now appear in the list of the user-defined variables. Double-
clicking on a user-defined variable allows a value to be defined or an existing 
value to be changed.

A BCS-2®  user-defined variable can be removed with the "Delete" button. The 
selected variable will be deleted.

13.3 Journal (optional)
Requirement: BCS-2® Journal module

The BCS-2®  Journal module generates user-defined entries in lists for certain 
transactions or events. For example a journal entry can be created each time 
an order is transferred, containing the current BCS-2® user, the order name, the 
date and time, etc.

The journals can be displayed in BCS-2®, or be exported as text or HTML files.

13.4 Cover Sheets Archiving (optional)

13.4.1 Cover Sheet Archiving Basic Settings
In order to save cover sheets in the defined directory,  the checkbox  "cover 
sheets are archived upon transfer" must be activated.

13.4.2 Definition of the Folder Structure
The folder levels in which the cover sheets are archived can be defined here.

Number of Cover Sheets:

The number of cover sheets to be archived can be selected with the "number 
of covers sheets to archive" pulldown box. Values from 1 to 10 can be select­
ed.

Creating a Folder Level:

To define a folder level the name of the folder is entered into the input box di­
rectly or created with the use of BCS-2® variables. Clicking the "add" button will 
create the folder with the selected name in the folder level list.

The topmost folder can be designated with the "top folder" button. A browser 
window will open where the folder can be selected.
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Changing/Moving/Deleting a Folder Level:

To change a folder name in the list, select the desired name with a double-click. 
The name will appear in the input box and can now be edited. With the "apply" 
button the edited name will overwrite the old one.

The folder list can be scrolled up and down with the "scroll up" and "scroll 
down" buttons. Clicking the "remove" button will delete the selected folder lev­
el.

Display of Folder and File Name:

In the lower area of the cover sheet management screen, the complete directo­
ry and file names of the cover sheets are displayed.

13.5 Receipt Printing (optional)
Requirement: corresponding BCS-2® PPC modules

In the context of  accounting systems it  is possible to print  receipts with the 
BCS-2® software. The content of the receipt can be defined with free text as 
well as BCS-2® variables.
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13.6 System Settings
Basic BCS-2® settings can be adjusted in the "System Settings..." option in the 
"Administration" menu.

Illustration 67: System Settings

These settings concern Performance Settings (Speed-Mode), adjustments to 
User-Help,  Image Transfer and more optional BCS-2® features (see screen­
shot):

 Speed-Mode is explained in the system settings, and is active by de­
fault.
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 With the  "User-Help Settings"  the paths where the "Product- and 
Application-Help" documents are stored are set. These can be called 
up with the "Help" menu (see chapter  15.1 page  100). Which of the 
two “helps” is displayed when the F1 key is pressed can also be de­
fined here.

 In the "Image Transfer before Next Scan" area the direct coping of 
scanned images within an order can be activated. A target directory 
can be defined and if desired a directory confirmation message acti­
vated (see screenshot).

 In  the  "WalkUp  Emulator"  area  multiple  settings  for  running  the 
BCS-2® software in the WalkUp mode when used in conjunction with a 
touchscreen can be edited.

13.7 Dynamic Order-Types
It is also possible to create custom order-types based on existing order-types 
with BCS-2®. This function is accessed via the "Dynamic Order-Type Admin­
istration..." menu point in the "Administration" menu. Upon selection the fol­
lowing dialog window opens:

Illustration 68: Dynamic Order-Type Administration Dialog Window

Within this administrative overview list for managing Order-Types, the buttons 
Append, Edit  and  Delete  will  perform the corresponding functions.  Further­
more the visibility of each Order-Type in the dropdown menu in the dropdown 
bar can be defined with the checkboxes in the "visible (type-selector)" col­
umn.

Caution: Editing or deleting an order is only possible if no scan orders of the 
corresponding  type  exist.  Additionally,  the  basic  scan-order-types  cannot  be 
edited or deleted.

New Order-Types are defined with the "Append" button:
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Illustration 69: Generating an Order-Type

A  name,  abbreviation  (maximum four  letters),  description  and  shortened 
name can be entered here.

Furthermore, a basic order-type needs to be attributed to the new order-type. 
This basic order-type will considerably influence what occurs when an order is 
transferred.

Now the order options for the custom order can be individually adjusted in the 
options dialog window in the "Order" menu (see chapter  5.5 page  24). Each 
new order-type has its own set of settings, this way individual order indexes can 
be defined, etc. without "destroying" important setting of existing order-types.
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13.8 Import Settings (optional)
Requirement: BCS-2® Import module

The following file types can be imported into orders if the optional import mod­
ule is activated:

 PDF files (optional)

 Winword documents

 Excel sheets

 Powerpoint presentations

 pure text files (.txt)

 HTML files (.htm or .html)

 ZIP files

The directory of the file  to be imported into the order can be set in the import 
settings.

Illustration 70: Import Settings

If files are now added to the order with the "Import Image Files..." option in the 
"Order" menu, BCS-2® will use the directory set in the import settings. However 
only if the option "Always use the default import folder for import?" is acti­
vated there.

13.9 OCR Settings (optional)
Requirement: BCS-2® OCR module and BCS-2® OCR engine

Settings for text recognition can be adjusted here.
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14  MYBIB MENU 
MyBib eDoc®, is a web based document delivery system, used by libraries and 
service bureaus as a workflow system for electronic document delivery and dig­
italization of expansive book and file collections. The "MyBib" menu is clarified 
in a separate document.
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15  HELP MENU 

15.1 Help, Documentation and Information
The "Help" menu offers access to the functions:

 User-Help for the product and its user. The content shown for each of 
the two user help options can be defined in the "System Settings..." 
in the "Administration" menu (see chapter 13.6 page 95).

By default, this manual is opened in PDF format when the "Product 
User-Help " option is selected.

The "Application User-Help" option opens the document defined in 
the  "System Settings..." (see above). For example personal notes for 
BCS-2®, or a custom user help text.

 Keyboard Short-Cuts for BCS-2®  in the standard web browser (see 
chapter 4.5 page 15)

 Documentation  of  System Variables shown  in  the  standard  web 
browser. The name, category, English and German descriptions and 
the value of variables are displayed in an HTML table.

 About  BCS-2®:  summary  information,  the  licensed  options,  and 
among other things the expiration date of the currently used license 
are displayed.

 ImageWare  Components  Homepage (www.imageware.de)  is 
opened in the standard web browser.

15.2 Support
Should you need additional  support  or  help,  select  the appropriate  support 
form point in the "Help" menu. You can choose between:

 Printed Support  Form:  You  can express your  questions  and con­
cerns here. Please complete the given information. Once completed, 
the test can be printed and faxed to ImageWare under the fax number 
+49-228-96985-84.

 E-Mail  Support  Form  (optionally  with  current  scan  attached): 
Opens your mail program (MAPI) with the  support form for comple­
tion.

Caution: It  is recommended that support questions be sent by mail  as 
these can be answered more quickly. Please include your license number 
and program version.  The same applies for  support  questions to your 
dealer.
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